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Contents of Package:
 D-Link DP-300U 
 Fast Ethernet Print Server
 Manual and Warranty on CD
 Printed Quick Installation Guide 
 

Package Contents

If any of the above items are missing, please contact your reseller.

System Requirements:

 

 

 

 A  computer with an installed Ethernet adapter  

Windows XP/2000/NT4/ME/98SE/95   

Apple Mac OS with AppleTalk  

Linux, Solaris, SCO Unix, AIX  

NetWare 5.x (Native NDS)  

Internet Explorer 6.0, or Netscape Navigator version 6.0 or above, 
with JavaScript enabled

  

Printer must support required Operating System  
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Introduction
The D-Link DP-300U Print Server is an Ethernet/USB print server that connects 
to your Ethernet/Fast Ethernet network anywhere you wish to locate printer 
services. The DP-300U manages the flow of print files from workstations or file 
servers to connected printers, delivering print jobs to printers much faster than a 
file server or a PC acting as a print server can. With one USB (v2.0) port and two 
IEEE 1284 parallel ports, the  DP-300U can connect to almost any printer with a 
USB port.

The DP-300U includes easy-to-use software to install on most Windows-based 
networks. Protocol support for TCP/IP, NetBEUI, and AppleTalk are provided to 
ensure seamless connection to major networking Operating Systems.

The DP-300U has a built in Web-Based management feature that allows users to 
easily configure and manage multiple print queues through TCP/IP. The DP-300U 
also supports Telnet as an alternative method to configure the unit.

The DP-300U improves network printing services in the following ways:

 The DP-300U picks up the workload of managing print file traffic to its 
connected printers. This provides workload relief to your file servers, and 
allows the file serversí full capacity to be used for file access or other direct 
services to network users. On peer-to-peer networks, workstations can print 
directly to the Print Server without increasing the load of another workstation 
or server



  

         Because the DP-300U is very portable and inexpensive compared to a PC-
based print server, and the Print Server connects to your file servers through 
the network, printers can be deployed to locations of maximum   
convenience to users.

 

The DP-300Uís parallel printer ports are IEEE1284-compliant high-speed 
bi-directional ports, which can transmit to high-speed laser printers much 
faster than a PCís parallel printer port. High-speed laser printers 
connected to the Print Serverís parallel ports can be operated at their full 
capacity.
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External Features
Port Connectors
The DP-300U’s three printer ports are located on its rear panel. One USB and 
two identical parallel ports are labeled USB, LPT1 and LPT2. These printer ports 
are independently configurable using the PS Admin program or the print serverís 
Telnet interface. (See the PS Admin User’s Guide, available on the CD that came 
with the DP-300U, for information about configuring the print server’s ports.) The 
Print Server also supports web configuration permitting users to configure settings 
through the web browser. Default IP Address as follows:

 Default IP Address – 192.168.0.10

 Subnet Mask – 255.255.255.0

The DP-300U offers extraordinary flexibility, operating with all major network 
operating systems and protocols:

 TCP/IP
 UNIX lpr/lpd (HP-UX, SunOS, Solaris, SCO, UnixWare, IBM AIX)
 Windows NT/2000, Windows 95/98SE/ME, Windows XP
 NetWare 5.x NDPS LPR Remote Printing

 NetBEUI

 Windows NT/2000/XP, Windows 95/98SE/ME, Windows for Workgroups,   
Microsoft LAN Manager, IBM LAN Server

 AppleTalk

 MacOS EtherTalk
Windows-based setup and administration software, PS Admin, is supplied with 
the Print Server, making configuration and management quick and easy. The 
Print Server also supports configuration and management via the Telnet protocol 
for networks without Windows-compatible machines. 

Note:
The PC’s IP Address must be in the same subnet as the Print Server’s IP Address for 
the two devices to communicate. (For example, if your Print Server’s IP Address is 
192.168.0.10, with a subnet mask of 255.255.255.0, then your computer’s IP Address 
should be 192.168.0.x, where x is a value between 1-254, excluding 10.)
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Network Cable Connector
The Print Server’s rear panel features an RJ-45 connector for connection to 
10Base-T Ethernet cabling or 100Base-TX Fast Ethernet cabling (which should 
be Category 5 twisted-pair cable).  The port supports the NWay protocol, allowing 
the Print Server to automatically detect or negotiate the transmission speed of the 
network.

DC Power Connector
The DC power input connector is located on the Print Server’s rear panel and is 
labeled DC 5V.

Rear Panel Connectors

USB RJ-45LPT1LPT2Power

LED Indicators
The front panel of the Print Server features five LED indicators:



 
7

              Power
       Steady or flashing green confirms that the Print Server is powered   

 ON.

  Link/Act
        Steady or flashing green confirms that the Print Server has a good      
         connection to the Ethernet or Fast Ethernet network.
       The indicator blinks off briefly to indicate that the Print Server is           
  receiving or transmitting from the network.
                  USB, LPT1, LPT2
                  
  
These three indicators are also used by the Print Server’s Power-ON Self Test 
(POST) to indicate any hardware failures.

Setting up the DP-300U
Installing the Print Server
WARNING: Configuration problems may result if the Print Server is powered up without 
first establishing its network connection. Follow this procedure to avoid complications at 
the configuration stage.



Confirm proper operation of each of the printers to be connected to the              
DP-300U.

1.

When you have confirmed proper operation of each printer, switch its power 
OFF.

2.

Confirm that your network is operating normally.3.

Connect the DP-300U RJ-45 Connector to the network, using an Ethernet 
CAT5 cable.

4.

While the printer is powered OFF, install the USB or parallel printer cable to con-
nect the printer’s USB port to the USB or aprallel port of the Print Server.

5.

Switch on each connected printer.6.

Plug the AC power adapter’s DC output plug into the DC 5V power socket on 
the rear panel of the Print Server.

7.

Plug the power adapter into a power outlet. This will supply power to the Print 
Server, as it has no external power switch. The green Power LED on the Print 
Server’s front panel should illuminate steadily, and the Print Server’s Self-Test 
will proceed.

8.

Front Panel LED Indicators


These LED indicators light to show that the Print Server is transferring 
print data through the appropriate parallel port or USB port.
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Immediately after power-up, all five of the green LEDs should illuminate steadily 
for several seconds. Then the USB, LPT1 and LPT2 LEDs should flash ON 
simultaneously three times. Irregularity of any of the three LEDs during these LED 
tests may mean there is a problem with the LEDs themselves. 
The actual component tests immediately follow the LED tests. A normal (no fault) 
result is signaled by a simultaneous flashing of these three LEDs, followed by a 
quiescent state with all three LEDs dark.
If the Self-Test routine traps any component error, then following the LED tests 
the Self-Test will halt and the LEDs will continuously signal the error according to 
the following table. In the event of any such error signal, contact your dealer for 
correction of the faulty unit.

When the DP-300U is powered ON, it also automatically performs a Self-Test 
on each of its major components. The final result of the Self-Test is signaled by 
the state of the USB, LPT1 and LPT2 LED indicators following the Self-Test. 
Preliminary to the actual component tests, the three LED indicators are tested to 
confirm their steady and flashing operation.

Power ON Self-Test
Every DP-300U has been factory-tested to operate properly.

LPT1 
Faulty Component

low speed flashing Need to reload firmware

ON DRAM error

1 long   8 short LPT1 Controller error

1 long   6 short LAN Controller error

1 long   5 short Flash Erase/Program error

1 long   3 short Flash Protected

1 long   2 short Timer INT error

USB error

 LED Name
USB LPT2

1 long  18 short

1 long  14 short MII error

1 long  12short LPT2 Controller error

1 long  13 short LPT2 error

LPT1 error1 long   9 short
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Getting Started
Below is a sample network using the DP-300U. The DP-300U has a built- in Web-
based management feature that allows users to easily configure and manage 
multiple print queues through TCP/IP.

Warning!  
Only a USB printer may be connected to the USB port of the  DP-300U. Do not 
connect any other USB devices to the USB port of the DP-301U; to do so, may 
damage the unit and will void the warranty for this product.

For a list of printers that are compatible with the DP-301U, please see the     Ap-
pendix in this manual. The compatibility list is not comprehensive. Even if it is 
not included in the list,  your printer may be compatible with the DP-300U.
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When you entered the default IP address, the main screen of the Print Server’s 
configuration will appear (see below).  In addition to the product information, you 
can access and control the Print Server’s configuration through four links on the top 
of this main screen: Home, Configuration, Tools, and Help.

Open your web browser and type http://192.168.0.10 in the address box, and 
press <Enter>.  This set of numbers is the default IP Address of your Print Server.  
Please note that the PC’s IP Address must correspond with the Print Server’s 
IP Address in the same segment for the two devices to communicate.

Using the  Web Configuration
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Home 
Click on Home tab from the tools bar of the main screen to display information of 
the DP-300U’s System Status and Printer Status.

As shown below, the System displays the status of your print server, printer and 
network. Clicking Refresh will update the information.

Home > System

Device Status:  Information about the print server, including the firmware version, 
MAC/IP address, and  the “up time” can be found in this field.
Printer Status: The items in this field display information about the printer, such as 
the given name of the printer, speed, printer status, and the status of your printing 
tasks, etc.
Ethernet Status: You can monitor the networking status in this field, including the 
network connection, speed, and the packets status.

Using the  Web Configuration (continued)
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Click the Network button in the left column to display information about the wireless 
LAN. Clicking Refresh will update the information.

Using the Web Configuration (continued)
Home > Network

Auto IP: This field contains the current settings of TCP/IP, including DHCP/BOOTP, 
UPnP, and MAC Rendezvous. The items in this field are configured in 
Configuration>Network>TCP/IP.

TCP/IP Printing: In this field, you can monitor the status of your printing tasks 
through TCP/IP.

Microsoft Network Printing: In this field, you can monitor the status of your 
printing tasks through Microsoft Network.

Mac AppleTalk Printing: In this field, you can monitor the status of your printing 
tasks through Mac AppleTalk.
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Click the User button in the left column to display the user’s information.

Using the Web Configuration (continued)

Home > User

Users Printing Log: The items in this field display the user(s) information, which 
include the user(s) Mac address, IP address, name, and status of printing tasks.
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Click on Configuration tab from the tools bar of the main screen to enter the Con-
figuration Page; it provides the configuration options that include System Device 
and Port Setting

System Device and Port Setting
This option will show you settings required to configure the DP-301U Print Server.  
Consult your printers owner manual for the PJL(Printer Job Language) and print 
speed supported on your printer.  Click the <Save> button on the bottom of the 
configuration  page to ensure the settings are updated and saved. 

Using the  Web Configuration (continued)

Server Name: Assign a name to the print server.
Location (optional): Assign a location for the print server.

Admin contact (optional): Assign the Admin’s contact name for the print server.

Port Settings

 In this field, you can assign the Port Name for the print server, and the description 
for the USB port. It also allows you to select the PJL Printer setting (Yes or No).

Password: Enter the Administrator password (3-8 characters). To set up the 
password, please enter the password in the New Password box, and then enter 
the same one again in the Confirm Again box.

NOTE: PJL (Print Job Language) has certain job requirements that must be met to 
work correctly. for more information, please refer to your printer’s manual.

Configuration
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Using the Web Configuration (continued)

Configuration > Network

TCP/IP
This field contains three options that allow you to configure the TCP/IP setting:

IP Address: This option allows you to set the IP address manually or automatically. 
When you choose Manually Assign, you should enter the related information in 
the following boxes, including IP Address, Subnet Mask, and Default Gateway.

UPnP: This option allows you to enable or disable UPnP mode.

MAC Rendezvous: This option allows you to enable or disable MAC Rendezvous 
mode.

WEP Encryption: This option allows you to select Disable, 64-bit, and 128-bit for 
encryption setting.

Microsoft Network
Enter the name of the Workgroup that you want the print server associated with in 
this field.

AppleTalk
Enter the AppleTalk Zone name in the box. In the following options, enter the related 
configuration, such as the printer type.

USB/LPT1/LPT2
Chooser Name: Display the print server name.

Printer Type: Enter the printer’s type in this box.

PostScript Level: Select from the pull-down menu (Level 1 or Level 2).

Font Group: Select from the pull-down menu.

TIP: Once you have changed the settings in each option, click Apply to store the 
settings.
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Network
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Using the Web Configuration (continued)
Configuration > User

Printing Control
By configuring the Enable User Printing Control option (Yes or No), the user in 
the User List is permitted to access the print server or not. 

Define Users
You can add/delete the user(s) to/from the User List. The User List at the bottom 
of the screen displays the current defined user and related information for the 
print server.

Click Apply to save the changes.
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Using the Web Configuration (continued)
Configuration > SNMP

SNMP Management
SNMP (Simple Network Management Protocol) is a set of protocols for managing
complex networks.

Community 1/2/3:  Enter a name in the Name box, 
   and configure the Access Right
   by selecting Read Only or Read/Write 
   from the pull-down menu.

Click Apply if you have made changes.



 
19

Tools

Using the Web Configuration (continued)

Print Test
Click Test to print a test page.

Click on the Tools link from the tools bar of the main screen to enter the Tools
Page; it provides the control options that include Print Test , E-mail, Reset,
Upgrade, and Backup.

Tools > Print Test
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Using the Web Configuration (continued)
Tools > Email

You can assign an E-mail address to the print server, so that the mail from the 
account can be printed out directly through the printer (ASCII test only). To enable 
this function, enter the E-mail account in the Print Server E-mail Address box.

Incoming E-mail (POP3) Server Address: Enter the server address that is used 
to receive your E-mail in this box.

Outgoing E-mail (SMTP) Server Address: Enter the server address that is used 
to send your E-mail in this box.

E-mail Account

If your mail server needs to verify the user when sending E-mail, the DP-G310 will 
apply the same Account Name and Password to the mail server as it does when 
receiving E-mail.
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Using the Web Configuration (continued)
Tools > Email (continued)

E-mail Notification
You can set the print server to send a message through E-mail  when the printer 
status changes. To enable this function, set the Enable e-mail notification
for printer status changing option to Yes. Then, input the administrator’s Email
address in the Admin E-mail Address box.

E-mail Printing
E-mail Printing (ASCII Text Only): Select Enable to enable the E-mail printing
function.
Receive E-mail Interval: Enter the number in this box to set up the time (in 
minutes) to check/receive E-mail regularly.
Test E-mail Account: Click Test to send a test E-mail to the given administrator’s 
Email address.
Receive E-mail: Click Yes to immediately check and receive E-mail, and then 
print out the mail when available.

Reset

Reset
Click Apply to 
immediately reset 
the print server.

Factory Reset
Click Apply to 
reload the factory 
settings of the print 
server.
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Using the Web Configuration (continued)
Tools > Upgrade

Firmware Upgrade
When a new version of firmware is available (e.g., downloaded from the 
manufacturer’s website), you can upgrade the firmware of your print server. Click 
Browse to locate the firmware file, then click Apply.
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Using the Web Configuration (continued)
Tools > Backup

Backup Device Configuration to File
Click Apply to backup your current configuration of the print server to file and 
then
save in the computer.

Restore Device Configuration from File
You can reload a configuration that you saved before. Click Browse to point to 
the backup file, and then click Apply.
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Help

Click on the Help link from the tools bar of the main screen to enter the Help Page, 
it provides a link to D-Link’s support website.  D-Link’s support website will provide 
the most up to date information on your DP-301U Print Server.  Please check the 
website regularly for product and firmware updates.
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TCP/IP Printing for Windows XP
Open the web browser, and type in the IP Address of the DP-300U.
For example, type http://192.168.0.10 into the Location or Address field. Press 
the Enter or (Return) Key.

Note:
The PC’s IP Address must be in the same subnet as the Print Server’s IP 
Address for the two devices to communicate. (For example, if your Print 
Server’s IP Address is 192.168.0.10, with a subnet mask of 255.255.255.0, 
then your computer’s IP Address should be 192.168.0.x, where x is a value 
between 1-254, excluding 10.) See Networking Basics: Assigning a Static IP 
Address in this manual to find out how to change an IP Address.

D-Link DP-301U
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TCP/IP Printing for Windows XP (continued)
At the Configuration  window,  write down the Port Name for future reference.  
You will need this information later in the configuration process.
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TCP/IP Printing for Windows XP (continued)
When you select TCP/IP Protocol at the Network window, the screen below 
appears.  (We recommend that you keep the default settings as shown.)  If 
you need to make changes, make sure to click Apply after you have made the 
changes. (You may wish to make a note of the IP Address.) 
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Go to Start > Settings > 
Printers and Faxes > 
Add a Printer

Click Next

TCP/IP Printing for Windows XP (continued)
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TCP/IP Printing for Windows XP (continued)

Select Local Printer

Click Next

Select Create a new port. At 
the pull-down menu, highlight     
Standard TCP/IP Port.

Click Next

Click Next

Deselect Automatically 
detect and install my 
Plug and Play printer.
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Click OK

Input the Port Name of 
the port being used by 
the printer.

Select LPR

Select  Custom
Then click  Settings

TCP/IP Printing for Windows XP (continued)

Type in the IP address 
of the Print Server (i.e. 
192.168.0.10). The Port 
Name will automatically 
be filled in.
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Click Finish

TCP/IP Printing for Windows XP (continued)

Click Next

Highlight the printer, as shown. 
If the desired printer is not on 
the list, click Have Disk and 
insert the printer driver disk that 
came with your printer to install 
the printer drivers.

Click Next
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At this screen, you can input a 
name for the printer.

Click Next

Click Next

TCP/IP Printing for Windows XP (continued)

Click Finish
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TCP/IP Printing for Windows 2000
Open the web browser, and type in the IP Address of the DP-300U.
For example, type http://192.168.0.10 into the Location or Address field. Press 
the Enter or (Return) Key.

Note:
The PC’s IP Address must be in the same subnet as the Print Server’s IP 
Address for the two devices to communicate. (For example, if your Print 
Server’s IP Address is 192.168.0.10, with a subnet mask of 255.255.255.0, 
then your computer’s IP Address should be 192.168.0.x, where x is a value 
between 1-254, excluding 10.) 

D-Link DP-301U
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TCP/IP Printing for Windows 2000 (continued)
At the Configuration  window,  write down the Port Names for future reference.  
You will need this information later in the configuration process.
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TCP/IP Printing for Windows 2000 (continued)
When you select TCP/IP Protocol at the Network window, the screen below 
appears.  (We recommend that you keep the default settings as shown.)  If 
you need to make changes, make sure to click Apply after you have made the 
changes. (You may wish to make a note of the IP Address.)
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Go to Start > Settings > 
Printers

Double-click on the Add 
Printer icon.

Click Next

TCP/IP Printing for Windows 2000 (continued)
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TCP/IP Printing for Windows 2000 (continued)

Select Local Printer

Click Next

Select Create a new port at the 
pull-down menu, highlight Standard 
TCP/IP Port. 

Click Next
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TCP/IP Printing for Windows 2000 (continued)

Click Next

Click Next

Type in the IP address of the Print 
Server in the Printer Name or IP Ad-
dress field. The Port Name field will 
automatically be filled in.

Select “Custom”
Then click on Settings.
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TCP/IP Printing for Windows 2000 (continued)

Click Finish

Click OK

Input the Port Name of 
the port being used by 
the printer.

Select LPR

Click Next
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Click Next

At this screen, you can input a 
name for the printer.

Click Next

Highlight the printer, as shown. 
If the desired printer is not on 
the list, click Have Disk and 
insert the printer driver disk that 
came with your printer to install 
the printer drivers.

TCP/IP Printing for Windows 2000 (continued)
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TCP/IP Printing for Windows 2000 (continued)

Click Next

Select Yes to print a test page

Click Next

Click Finish
The printer is now ready for 
printing with Windows
2000  on your network.

Select Do not share this printer
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D-Link DP-301U

Note:
The PC’s IP Address must be in the same subnet as the Print Server’s IP 
Address for the two devices to communicate. (For example, if your Print 
Server’s IP Address is 192.168.0.10, with a subnet mask of 255.255.255.0, 
then your computer’s IP Address should be 192.168.0.x, where x is a value 
between 1-254, excluding 10.) 

TPC/IP Printing
For Windows 98SE/ME
Open the web browser, and type in the IP Address of the DP-300U.
For example, type http://192.168.0.10 into the Location or Address field. Press 
the Enter or (Return) Key.



 
43

TCP/IP Printing for Windows 98SE/ME 
(continued)
At the Configuration  window,  write down the Port Name for future reference.  
You will need this information later in the configuration process. The Port Name 
shown here is only an example.
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When you select TCP/IP Protocol at the Network window, the screen below 
appears.  (We recommend that you keep the default settings as shown.)  If 
you need to make changes, make sure to click Apply after you have made the 
changes. (You may wish to make a note of the IP Address.)

TCP/IP Printing for Windows 98SE/ME 
(continued)
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TCP/IP Printing for Windows 98SE/ME 
(continued)

Go to Start > Settings > 
Control Panel 
Double-click on Network   

Click Add

Highlight Client

Click Add
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At this window, 
click Have Disk.

Click OK to accept the 
location of the file.

23

1

4

1. 

2.

3. Highlight lpr.inf

4. Click OK

Insert the DP-301U 
CD-ROM into your 
CD-ROM  drive.  
Select the letter 
representing the 
CD-ROM drive on 
your computer from  
the pull-down menu.

Double-click on 
the folder lpr.

TCP/IP Printing for Windows 98SE/ME 
(continued)
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TCP/IP Printing for Windows 98SE/Me 
(continued)

Click OK

You should now be 
back to the Network 
Properties Page.
Highlight LPR for 
TCP/IP Printing.

Click Properties
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The Port name and IP 
Address will be displayed. 
(The Port Name at right is 
just an example.)

Click OK

Type in the IP Address of 
the DP-301U. Make sure 
the Port Name is accu-
rate. (The Port Name at 
right is just an example.)

Click OK

Click Add Port

TCP/IP Printing for Windows 98SE/ME 
(continued)
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Click OK

Windows will ask for 
a restart.

Click Yes

TCP/IP Printing for Windows 98SE/ME 
(continued)
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Once your computer has rebooted, click on 
Start  > Settings  > Printers  > Add Printer

When  the Add Printer Wizard 
screen appears, Click Next.

Select Network Printer. 

Click Next

Type in the path if you know it, 
or Click Browse.

TCP/IP Printing for Windows 98SE/ME 
(continued)
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At the next screen, browse for the printer 
port. Highlight the port as shown. (The Port 
Name in this window is just an example.)

Click OK

If the network path is not specified, type in 
the IP Address of the DP-301U and the Port 
Name. (The Port Name shown at right is 
just an example.)

Select Yes or No, to answer the question:
Do you print from MS-DOS based pro-
grams?

Click Next

Click Next

Click Next

PS-1123D6-P1

Highlight the printer, as shown. If the desired 
printer is not on the list, click Have Disk and 
insert the printer driver disk that came with 
your printer to install the printer drivers.

TCP/IP Printing for Windows 98SE/ME 
(continued)
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Select Yes to print 
a test page.

Click Finish

Go to Start > 
Settings > Printers
Check to see that your 
printer is installed.

TCP/IP Printing for Windows 98SE/ME 
(continued)
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Unix/Linux Printing

Please refer to the PS Admin Manual on the CD included with your purchase for 
information on setting up the Print Server in Unix/Linux.
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Setting up Apple Talk or LPR Print-
ing in Mac OS X

At the Configure 
pull-down menu, 
select Manually

Note: Mac OS printing is supported by Postscript printers only!

Open your Sys-
tem Preferences 
window and Click 
Network. 

With Mac OSX you can use AppleTalk or LPR printers using IP protocols for print-
ing through Print Servers. Follow the instructions below for setting up the Print 
After attaching the Print Server to your network using the directions provided in the 
Quick Installation Guide, change the IP Address of your Macintosh to access the 
Print Server’s web configuration. 
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The default IP 
Address of the 
Print Server is 
192.168.0.10. 
Manually change 
your IP Address to 
192.168.0.x, where 
x is any number 
between 1 and 254 
(except 10 which is 
the IP Address of 
the Print Server.)  
The IP Addresses 
and Subnet Mask 
shown here are 
examples only.

Setting up Apple Talk or LPR Printing
in Mac OS X (continued)

Select the AppleTalk 
tab in this window  
and check Make 
AppleTalk Active.
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To print, open a document 
and select File > Print 
from the menu.

Select Edit Printer 
List from the Printer 
dialog box.

Click  Add Printer

Setting up Apple Talk or LPR Printing
in Mac OS X (continued)
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Select the printing pro-
tocol preferred, Apple-
Talk or LPR Printers 
using IP.

AppleTalk protocol: 
After selecting 
AppleTalk the Port 
Name of the Print 
Server will be dis-
played. The Port 
Name shown here is 
an example only.

Click on the Port to 
which the post-script 
printer is connected. 

In this example, 
AppleTalk has been 
selected.

PS - 1123D6-U1  Laserwriter

Then select the printer model from the dialog box displayed here. 
Click Add Printer and the Printer Port configuration  is complete. 
Select the Printer Port just configured in the Print window.
Click Print to print your document.

PS - 1123D6-U1  Laserwriter

Setting up Apple Talk or LPR Printing
in Mac OS X (continued)
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LPR Printers using IP 
protocol: 
When you select LPR 
Printers using IP Proto-
col, this window  will ap-
pear. 

Type the IP Address of 
the Print Server into the 
LPR Printer’s Address 
field. 

In the Queue Name field, type in the Port Name of the post-script printer that is 
connected to the Print Server. The Port Name illustrated here is only an example.
Select the printer model from the dialog box. 
In the Queue Name field, type in the Port Name of the post-script printer that is 
connected to the Print Server. The Port Name illustrated here is only an example.

Select the printer model from the dialog box. 

Click Add and the process is complete. 

Close all Print Center windows, select the Printer Port that was just selected.  

Click Print to print the document.Click Add and the process is complete. 

PS-1123D6 - U1

Setting up Apple Talk or LPR Printing
in Mac OS X (continued)
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Setting up Apple Talk Printing
in Mac OS 9

The AppleTalk network protocol is used with computers using the MacOS operating 
system. It can be used for network communications over standard Ethernet or Fast 
Ethernet using the EtherTalk transport, or over a proprietary low-speed LocalTalk 
transport.

Your Print Server can be used for network printing to PostScript printers. You can 
print from any MacOS computer connected to your Ethernet network, either directly 
using an EtherTalk connection, or indirectly through a LocalTalk-to-EtherTalk 
router.

NOTE: The Chooser name of a printer connected to one of the Print Server’s ports 
is the same as its Port Name. If you are using AppleTalk printing, you will need to 
make sure that every Port Name is unique among all of the network printers in 

Setting up the Print Server for AppleTalk Printing
To set up your Print Server so that it can be used for AppleTalk printing:

Note: Mac OS printing is supported for Postscript printers only!

If your AppleTalk network is divided into AppleTalk zones, you will have to 
specify which zone the Print Server should be in. You should locate the Print 
Server in the same zone as most of the users who will be using it. If your 
network is not divided into zones, the AppleTalk Zone field should contain a 
single asterisk “*”.

Select the Network tab and scroll to the bottom to the AppleTalk protocol 
section

Change the IP Address on one of the computers on your network to 
192.168.0.x, where x is any number between 11-254. 

Type 192.168.0.10 into the address field of your web browser. 192.168.0.10 
is the default IP Address of the DP-301U.

Make sure the AppleTalk protocol is enabled in your Macintosh. 

 

 

 

 
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Printing from MacOS Client Workstations
The exact procedure for selecting a PostScript printer connected to your Print 
Server may vary slightly, depending on what printer driver version you are using. 
The procedure described below assumes you are using the LaserWriter 8.

To choose a printer connected to your Print Server as your MacOS
workstation’s default printer,

  Open the Chooser by selecting Chooser from the Apple menu.

 Select the LaserWriter 8 icon on the left. Make sure that AppleTalk is set  
 to Active.

  A list of all networked PostScript printers will be displayed:

Double-click the name of 
the Printer Port you wish 
to use. The Printer Ports 
shown are examples only.

PS-1123D6-U1
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Printing from MacOS Client Workstations 
(continued)
If you have not 
previously set this printer 
as the default, your 
computer will prompt you 
for a PostScript Printer 
Description file. Choose 
Select PPD.

If you wish to access this setting in the future, you can use the Setup button in the 
Chooser window.

 The selected printer will become your computer’s default printer. You may need to 
choose Page Setup in any applications you have open.

Select the appropriate 
printer description file for 
your printer.

Click Open. 
(If your printer is not 
listed, click Generic to 
use a generic printer 
description.)
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Networking Basics
Using the Network Setup Wizard in Windows XP

In this section you will learn how to establish a network at home or work, using 
Microsoft Windows XP.  

Note:  Please refer to websites such as http://www.homenethelp.com
and http://www.microsoft.com/windows2000  for information about networking 
computers using Windows 2000, ME or 98SE.

Go to Start>Control Panel>Network Connections

Select Set up a home or small office network

When this screen appears, Click Next
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Networking Basics (continued)

Please follow all 
the instructions in
this window:

Click Next

Click Next

In this window, 
select the 
best description 
of your computer.     
If your computer 
connects to the 
internet through a 
gateway/router, 
select the second 
option as shown.
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Enter a Computer 
description and a 
Computer name 
(optional.)

Click Next

Enter a Workgroup 
name.  All comput-
ers on your network 
should have the 
same Workgroup 
name.

Click Next

Networking Basics (continued)



 
65

Please wait while 
the Network 
Setup Wizard ap-
plies the 
changes.

When the changes 
are complete, 
Click Next.

Please wait while 
the Network 
Setup Wizard 
configures the 
computer.
This may take a 
few minutes.

Networking Basics (continued)
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In this window, select 
the best option.  In 
this example, Create 
a Network 
Setup Disk has been 
selected.
You will run this 
disk on each of the     
computers on your 
network.  

Insert a disk into the 
Floppy Disk Drive, in 
this case drive A. 

Format the disk if you 
wish, and Click Next

Click Next

Networking Basics (continued)
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Please wait while the Network Setup Wizard copies the files.

Please read the information under Here’s how in the screen below.  After you 
complete the Network Setup Wizard you will use the Network Setup Disk to run 
the Network Setup Wizard once on each of the computers on your network.  To 
continue, Click Next. 

Networking Basics (continued)
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Networking Basics (continued) 
Please read the information on this screen, then click Finish to complete the 
Network Setup Wizard.

The new settings will take effect when you restart the computer. Click Yes to restart 
the computer.

You have completed configuring this computer.  Next, you will need to run the 
Network Setup Disk on all the other computers on your network. After running 
the Network Setup Disk on all your computers, your new wireless network will be 
ready to use.
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  

Networking Basics 
How to assign a Name to your computer
To name your computer, please follow these directions in Windows XP:

Click Start (in the lower left corner of the screen)

Right-click My Computer

Select Properties and Click



  

  

  

  

Select the Computer 
Name tab in the System 
Properties window.

You may enter a      
Computer Description 
(optional).

To rename the computer 
and join a domain, Click 
Change.

Networking Basics (continued)
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How to assign a Name to your Computer
  In this window, enter the 

Computer name

Select Workgroup and enter 
the name of the Workgroup

All computers on your 
network must have the same 
Workgroup name.

Click OK

  

  

 

How to find your IP Address in Windows XP

The adapter-equipped computers in your network must be in the same IP Ad-
dress range. To verify the IP Address of the adapter, please do the following:

Right-click on the 
Local Area Con-
nection icon in 
the task bar

Click on Status





Networking Basics (continued)
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How to find your  IP Address in Windows XP
This  window will appear.

Click the    
Support tab

Click Close

 

 

Assigning a Static IP Address in Windows XP/2000
Note:  Residential Gateways/Broadband Routers will automatically assign IP 
Addresses to the computers on the network, using DHCP (Dynamic Host Con-
figuration Protocol) technology.  If you are using a DHCP-capable Gateway/
Broadband Router you will not need to assign Static IP Addresses.
If you are not using a DHCP capable Gateway/Broadband Router, or you need 
to assign a Static IP Address, please follow these instructions:

  

  

Go to Start

Double-click  
Control Panel

Networking Basics (continued)
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Assigning a Static IP Address in Windows XP/2000

  Double-click  
Network 
Connections

  

  Double-click  
Properties

Right-click Local Area 
Connections

Networking Basics (continued)
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 Input your IP Address 
and subnet mask. (The 
IP Addresses on your 
network must be within the 
same range. For example, 
if one computer has an IP 
Address of 192.168.0.2, 
the other computers should 
have IP Addresses that are 
sequential, like 192.168.0.3 
and 192.168.0.4. The 
subnet mask must be the 
same for all the computers 
on the network.)

Networking Basics  (continued)
Assigning a Static IP Address
in Windows XP/2000

 Input your DNS server 
addresses. (Note: If you 
are entering a DNS server, 
you must enter the IP 
Address of the Default 
Gateway.)

The DNS server information will be supplied 
by your ISP (Internet Service Provider.)

Click OK

 Click Internet Protocol 
(TCP/IP)

 Click Properties

 

Select Use the following 
IP Address in the 
Internet Protocol (TCP/
IP)Properties window.

 

 

 

 

 
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Technical Specifications
Printer Connection
Printer Port: IEEE 1284 standard bidirectional parallel interface with 25-pin connector. 

USB port (ver 2.0)

Bidirectional Communication: 

Network Connection
Network Standards:  IEEE 802.3 10Base-T Ethernet

Network Data Transfer Rate:  10/100 Mbps (megabits per second) 

Network Connector:  RJ-45 connector for 10Base-T Category 5 twisted-pair connection 

Network Protocols
Ethernet Frame Types: 802.2, 802.3, Ethernet I I, SNAP (auto-switching)

Transport Protocols:  TCP/IP, NetBEUI,AppleTalk/EtherTalk, LPR

TCP/IP Protocols Supported: BOOTP, SNMP, Telnet, TFTP, FTP, LPD, RARP, DHCP

Management and Diagnostics
Standard:  SNMP MIBs:
 MIB-II (RFC 1213)

Diagnostic LED Indicators:  Pw, Lk/Act, LPT1, LPT2, USB

Environmental and Physical
Power Supply:  External power supply providing 5V/ 2.5A 

Dimensions:  7.58” x 4.66” x 1.22” (192.5mm x 118.4mm x 31 mm)

Weight:  approx. 10.3 oz. (292g)

Operating Temperature:  32 to122°F (0 to 50°C)

Storage Temperature:  -13 to 131°F (-25 to 55°C)

Humidity:  5% to 95% non-condensing

Emissions:  FCC Class B, CE Class B, VCCI Class B

Hewlett-Packard PJL (Printer Job Language) standard 
for bidirectional communication.
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You can find  software updates and user documentation on the D-Link website.

D-Link provides free technical support for customers within the United States and within 
Canada for the duration of the warranty period on this product.  

U.S. and Canadian customers can contact D-Link technical support through our website,  
or by phone.  

Tech Support for customers within the United States:
 D-Link Technical Support over the Telephone:
 (877) 453-5465
 24 hours a day, seven days a week.

 D-Link Technical Support over the Internet:
 http://support.dlink.com
 email:support@dlink.com

Tech Support for customers within Canada:
 D-Link Technical Support over the Telephone:
 (800) 361-5265
 Monday through Friday, 7:30am to 12:00am EST
 D-Link Technical Support over the Internet:
 http://support.dlink.ca
 email:support@dlink.ca

When contacting technical support, please provide the following information:

 •  Serial number of the unit

 •  Model number or product name

 •  Software type and version number

Technical Support
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Subject to the terms and conditions set forth herein, D-Link Systems, Inc. (“D-Link”) provides this Limited warranty 
for its product only to the person or entity that originally purchased the product from:

 D-Link or its authorized reseller or distributor and
 Products purchased and delivered within the fifty states of the United States, the District of Columbia, 

U.S. Possessions or Protectorates, U.S. Military Installations, addresses with an APO or FPO. 
Limited Warranty:  D-Link warrants that the hardware portion of the D-Link products described below will be free 
from material defects in workmanship and materials from the date of original retail purchase of the product, for the 
period set forth below applicable to the product type (“Warranty Period”), except as otherwise stated herein. 

1-Year Limited Warranty for the Product(s) is defined as follows:

 Hardware (excluding power supplies and fans)One (1) Year
 Power Supplies and Fans One (1) Year
 Spare parts and spare kits Ninety (90) days

D-Link’s sole obligation shall be to repair or replace the defective Hardware during the Warranty Period at no 
charge to the original owner or to refund at D-Link’s sole discretion.  Such repair or replacement will be rendered 
by D-Link at an Authorized D-Link Service Office.  The replacement Hardware need not be new or have an identical 
make, model or part.  D-Link may in its sole discretion replace the defective Hardware (or any part thereof) with 
any reconditioned product that D-Link reasonably determines is substantially equivalent (or superior) in all material 
respects to the defective Hardware.  Repaired or replacement Hardware will be warranted for the remainder of the 
original Warranty Period from the date of original retail purchase.  If a material defect is incapable of correction, 
or if D-Link determines in its sole discretion that it is not practical to repair or replace the defective Hardware, the 
price paid by the original purchaser for the defective Hardware will be refunded by D-Link upon return to D-Link of 
the defective Hardware.  All Hardware (or part thereof) that is replaced by D-Link, or for which the purchase price 
is refunded, shall become the property of D-Link upon replacement or refund.
Limited Software Warranty:  D-Link warrants that the software portion of the product (“Software”) will substantially 
conform to D-Link’s then current functional specifications for the Software, as set forth in the applicable 
documentation, from the date of original retail purchase of the Software for a period of ninety (90) days (“Warranty 
Period”), provided that the Software is properly installed on approved hardware and operated as contemplated in 
its documentation. D-Link further warrants that, during the Warranty Period, the magnetic media on which D-Link 
delivers the Software will be free of physical defects.  D-Link’s sole obligation shall be to replace the non-conforming 
Software (or defective media) with software that substantially conforms to D-Link’s functional specifications for the 
Software or to refund at D-Link’s sole discretion.  Except as otherwise agreed by D-Link in writing, the replacement 
Software is provided only to the original licensee, and is subject to the terms and conditions of the license granted 
by D-Link for the Software.  Software will be warranted for the remainder of the original Warranty Period from the 
date or original retail purchase.  If a material non-conformance is incapable of correction, or if D-Link determines 
in its sole discretion that it is not practical to replace the non-conforming Software, the price paid by the original 
licensee for the non-conforming Software will be refunded by D-Link; provided that the non-conforming Software 
(and all copies thereof) is first returned to D-Link.  The license granted respecting any Software for which a refund 
is given automatically terminates.
Non-Applicability of Warranty:  The Limited Warranty provided hereunder for hardware and software of D-Link’s 
products will not be applied to and does not cover any refurbished product and any product purchased through 
the inventory clearance or liquidation sale or other sales in which D-Link, the sellers, or the liquidators expressly 
disclaim their warranty obligation pertaining to the product and in that case, the product is being sold “As-Is” without 
any warranty whatsoever including, without limitation, the Limited Warranty as described herein, notwithstanding 
anything stated herein to the contrary.  

Submitting A Claim:  The customer shall return the product to the original purchase point based on its return 
policy.  In case the return policy period has expired and the product is within warranty, the customer shall submit 
a claim to D-Link as outlined below:
 

 The customer must submit with the product as part of the claim a written description of the Hardware 
defect or Software nonconformance in sufficient detail to allow D-Link to confirm the same. 

Warranty and Registration



 
77

 

 After an RMA number is issued, the defective product must be packaged securely in the original or other 
suitable shipping package to ensure that it will not be damaged in transit, and the RMA number must be 
prominently marked on the outside of the package.  Do not include any manuals or accessories in the 
shipping package.  D-Link will only replace the defective portion of the Product and will not ship back 
any accessories.

 The original product owner must obtain a Return Material Authorization (“RMA”) number from the 
Authorized D-Link Service Office and, if requested, provide written proof of purchase of the product 
(such as a copy of the dated purchase invoice for the product) before the warranty service is provided.

 

 The customer is responsible for all in-bound shipping charges to D-Link.  No Cash on Delivery (“COD”) 
is allowed.  Products sent COD will either be rejected by D-Link or become the property of D-Link.  
Products shall be fully insured by the customer and shipped to D-Link Systems, Inc., 53 Discovery 
Drive, Irvine, CA 92618.  D-Link will not be held responsible for any packages that are lost in transit 
to D-Link.  The repaired or replaced packages will be shipped to the customer via UPS Ground or any 
common carrier selected by D-Link, with shipping charges prepaid. Expedited shipping is available if 
shipping charges are prepaid by the customer and upon request.

D-Link may reject or return any product that is not packaged and shipped in strict compliance with the foregoing 
requirements, or for which an RMA number is not visible from the outside of the package. The product owner 
agrees to pay D-Link’s reasonable handling and return shipping charges for any product that is not packaged 
and shipped in accordance with the foregoing requirements, or that is determined by D-Link not to be defective 
or non-conforming.
What Is Not Covered: This limited warranty provided by D-Link does not cover: Products, if in D-Link’s judgment, 
have been subjected to abuse, accident, alteration, modification, tampering, negligence, misuse, faulty installation, 
lack of reasonable care, repair or service in any way that is not contemplated in the documentation for the product, 
or if the model or serial number has been altered, tampered with, defaced or removed; Initial installation, installation 
and removal of the product for repair, and shipping costs; Operational adjustments covered in the operating 
manual for the product, and normal maintenance; Damage that occurs in shipment, due to act of God, failures due 
to power surge, and cosmetic damage;  Any hardware, software, firmware or other products or services provided  
by anyone other than D-Link; Products that have been purchased from inventory clearance or liquidation sales or 
other sales in which D-Link, the sellers, or the liquidators expressly disclaim their warranty obligation pertaining to 
the product.  Repair by anyone other than D-Link or an Authorized D-Link Service Office will void this Warranty.
Disclaimer of Other Warranties: EXCEPT FOR THE LIMITED WARRANTY SPECIFIED HEREIN, THE 
PRODUCT IS PROVIDED “AS-IS” WITHOUT ANY WARRANTY OF ANY KIND WHATSOEVER INCLUDING, 
WITHOUT LIMITATION, ANY WARRANTY OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE 
AND NON-INFRINGEMENT. IF ANY IMPLIED WARRANTY CANNOT BE DISCLAIMED IN ANY TERRITORY 
WHERE A PRODUCT IS SOLD, THE DURATION OF SUCH IMPLIED WARRANTY SHALL BE LIMITED TO 
NINETY (90) DAYS. EXCEPT AS EXPRESSLY COVERED UNDER THE LIMITED WARRANTY PROVIDED 
HEREIN, THE ENTIRE RISK AS TO THE QUALITY, SELECTION AND PERFORMANCE OF THE PRODUCT 
IS WITH THE PURCHASER OF THE PRODUCT.

Limitation of Liability: TO THE MAXIMUM EXTENT PERMITTED BY LAW, D-LINK IS NOT LIABLE UNDER 
ANY CONTRACT, NEGLIGENCE, STRICT LIABILITY OR OTHER LEGAL OR EQUITABLE THEORY FOR ANY 
LOSS OF USE OF THE PRODUCT, INCONVENIENCE OR DAMAGES OF ANY CHARACTER, WHETHER 
DIRECT, SPECIAL, INCIDENTAL OR CONSEQUENTIAL (INCLUDING, BUT NOT LIMITED TO, DAMAGES 
FOR LOSS OF GOODWILL, LOSS OF REVENUE OR PROFIT, WORK STOPPAGE, COMPUTER FAILURE 
OR MALFUNCTION, FAILURE OF OTHER EQUIPMENT OR COMPUTER PROGRAMS TO WHICH D-LINK’S 
PRODUCT IS CONNECTED WITH, LOSS OF INFORMATION OR DATA CONTAINED IN, STORED ON, OR 
INTEGRATED WITH ANY PRODUCT RETURNED TO D-LINK FOR WARRANTY SERVICE) RESULTING 
FROM THE USE OF THE PRODUCT, RELATING TO WARRANTY SERVICE, OR ARISING OUT OF ANY 
BREACH OF THIS LIMITED WARRANTY, EVEN IF D-LINK HAS BEEN ADVISED OF THE POSSIBILITY OF 
SUCH DAMAGES. THE SOLE REMEDY FOR A BREACH OF THE FOREGOING LIMITED WARRANTY IS 
REPAIR, REPLACEMENT OR REFUND OF THE DEFECTIVE OR NON-CONFORMING PRODUCT.  THE 
MAXIMUM LIABILITY OF D-LINK UNDER THIS WARRANTY IS LIMITED TO THE PURCHASE PRICE OF THE 
PRODUCT COVERED BY THE WARRANTY. THE FOREGOING EXPRESS WRITTEN WARRANTIES AND 
REMEDIES ARE EXCLUSIVE AND ARE IN LIEU OF ANY OTHER WARRANTIES OR REMEDIES, EXPRESS, 
IMPLIED OR STATUTORY.
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Governing Law:  This Limited Warranty shall be governed by the laws of the State of California. Some states 
do not allow exclusion or limitation of incidental or consequential damages, or limitations on how long an implied 
warranty lasts, so the foregoing limitations and exclusions may not apply. This limited warranty provides specific 
legal rights and the product owner may also have other rights which vary from state to state.

Trademarks:  D-Link is a registered trademark of D-Link Systems, Inc. Other trademarks or registered trademarks 
are the property of their respective manufacturers or owners. 

Copyright Statement:  No part of this publication or documentation accompanying this Product may be 
reproduced in any form or by any means or used to make any derivative such as translation, transformation, 
or adaptation without permission from D-Link Corporation/D-Link Systems, Inc., as stipulated by the United 
States Copyright Act of 1976.  Contents are subject to change without prior notice.  Copyright© 2002 by D-Link 
Corporation/D-Link Systems, Inc. All rights reserved.

CE Mark Warning:  This is a Class B product. In a domestic environment, this product may cause radio 
interference, in which case the user may be required to take adequate measures.

FCC Statement:  This equipment has been tested and found to comply with the limits for a Class B digital 
device, pursuant to part 15 of the FCC Rules. These limits are designed to provide reasonable protection against 
harmful interference in a residential installation. This equipment generates, uses, and can radiate radio frequency 
energy and, if not installed and used in accordance with the instructions, may cause harmful interference to radio 
communication. However, there is no guarantee that interference will not occur in a particular installation. If this 
equipment does cause harmful interference to radio or television reception, which can be determined by turning 
the equipment off and on, the user is encouraged to try to correct the interference by one or more of the following 
measures:

Register your D-Link product online  at http://support.dlink.com/register/

Reorient or relocate the receiving antenna.

Increase the separation between the equipment and receiver.

Connect the equipment into an outlet on a circuit different from that to which 

Consult the dealer or an experienced radio/TV technician for help.

the receiver is connected.

 (2005/06/27)

FCC Caution:  Any changes or modifications not expressly approved by the party responsible for compliance 
could void the user’s authority to operate this equipment.

This device complies with Part 15 of the FCC Rules. Operation is subject to the following two conditions: (1)This 
device may not cause harmful interference, and (2) this device must accept any interference received, including 
interference that may cause undesired operation.

IMPORTANT NOTE:

This equipment complies with FCC radiation exposure limits set forth for an uncontrolled environment.  This 
equipment should be installed and operated with a minimum distance of about 8 inches (20cm) between the 
radiator and your body.

FCC Radiation Exposure Statement:

This transmitter must not be co-located or operated in conjunction with any other antenna or transmiter.
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Appendix:
DP-300U Printer Compatibility List

The Canon Printer 
USB:
Cannon BJC55, BJC85
Cannon S100SP
Cannon S200SP
Cannon S300
Cannon S330
Cannon S400SP
Cannon S520
Cannon S600
Cannon S6300
Cannon S750
Cannon S450
Cannon S4500
Cannon S9000
Cannon PIXUS 850i
Cannon I850
Cannon IP1000, IP3000, IP4000

Parallel:
Canon BJC-255SP
Canon BJ-330
Canon BJC-600, 620
Canon BJC-2000SP
Canon BJC-4100
Canon BJC- 4300
Canon BJC- 4500
Canon BJC- 4550
Canon BJC-6000
Canon BJC- 6500
Canon BJC-7000
Canon BJC-8200
Canon LBP-720
Canon BJC-740
Canon Bubble Jet S520

The Epson Printer
USB:
EPSON Stylus C41UX, C405, C60, 
C61, C80, C42UX, RX510, C43 , 
C45

EPSON Photo R310, 720, 810, 
820, 830, 830U, 890, 900, 1280, 
1290, PM860PT, CC550L, CC570L, 
CL750, CL760, MC-2000, PM680C, 
PM-720C,  PM-730C, PM-740C, 
PM740DU, PM-D750, PM-780CS, 
PM-790PT,  PM-800C, PM-800DC, 
PM-820C, PM-820DC, PM-830C, 
PM-840C, PM-850PT, PM-860PT, 
PM-870C, PM-890C, PM-G900, 
PM-920C, PM-930C,  PM-940C, 
PM-950C, PM-970C, PM-980C, 
PM-D1000, PM-2200C,  PM-3300C, 
PM-3500C, PM-3700C, PM-4000PX 
, PM-A850, PM-D750, PM-G700, 
PM-G800, E-100

EPSON Laser PX-V500, PX-V600, 
PX-V700, PX-G900, 900, 1160, 
2200, LP-1200, LP-1300, LP-1400, 
LP1500C, LP-2000C, LP-2400, 
LP-2500, LP-6100, LP-7000C, LP-
7500,  LP-7700, LP-7800, LP-7900, 
LP-8900, LP-9000B, LP-9000C, 
LP-9100, LP-9400,  LP-9500C, LP-
9800C

Parallel:
Epson Stylus Photo 700, 710, 750
Epson Stylus Photo 870
Epson Stylus Photo 1200, 1270
Epson Stylus Photo EX
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Appendix: DP-300U Printer Compatibility List (continued)

Parallel:
HP LaserJet III
HP LaserJet 4P, 4L, 4V
HP LaserJet 5L
HP LaserJet 6P, 6L
HP LaserJet 1100, 1100A
HP LaserJet 1200
HP LaserJet 2100, 2100M
HP LaserJet 2200
HP LaserJet 3150
HP LaserColorJet 8500
HP LaserJet 1100 series
HP LaserJet 1300 series
HP LaserJet 2100 series
HP LaserJet 3150
HP LaserJet 4000
HP LaserJet 5000
HP LaserJet 5100SE
HP LaserJet 9000
HP Color LaserJet 4600 PS
HP DeskJet 400, 420
HP DeskJet 500
HP DeskJet 550C, 560C
HP DeskJet 670C, 695C
HP DeskJet720C
HP DeskJet 810C, 890C
HP DeskJet 920C
HP DeskJet 930C(new), 970CXI
HP DeskJet 1120C, DeskJet 
1125C,
All in One Officejet HP T47, 710

Epson Stylus Pro XL
Epson Stylus Color 400, 440, 460, 480
Epson Stylus Color 600, 640, 660
Epson Stylus Color 740
Epson Stylus Color 800, 850, 860
Epson Stylus Color 900
Epson Stylus Color 1160
Epson Stylus Color 1500, 1520
Epson Stylus Color 3000
Epson Stylus C60
Epson LQ-100
Epson LQ-300
Epson LQ-550, 570+
Epson LQ-1070C+
Epson LQ-2070, 2170C
Epson EPL-N2000, N2010
Epson EPL-5500, 5700, 5700L, 5800

The HP Printer
USB:
HP Desk jet 640C, 650C
HP Desk jet 845C
HP Desk jet 920C
HP Desk jet 940C, 948C
HP Desk jet 960C
HP Desk jet 990Cxi, 995C
HP Desk jet 1125C, 1180C
HP Desk jet 1220C
HP Desk jet 3320
HP Desk jet 3420, 3425, 3845
HP Color Inkjet CP1700, 3535, 3650, 
3745 
HP Inkjet DeskJet5610, DeskJet5650, 
DeskJet5850 
HP laserJet 1200, 2200, 2200D, 1500
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The Lexmark Printer 
USB:
Lexmark Z13, Z25, Z33, Z35, Z43, 
Z45, Z53, Z615, Z810, Z818
Lexmark 4039 10R
Lexmark 5700
Lexmark Optra Color 45
Lexmark Optra C710
Lexmark Optra E, E+, E310, E230 
Lexmark Optra K1220
Lexmark Optra M410, M412
Lexmark Optra N,
Lexmark Optra R+
Lexmark Optra S1250, Optra S1855
Lexmark Optra SC-1275
Lexmark Optra SE-3455
Lexmark OptraT614
Lexmark Optra W810

Parallel:
Lexmark 4039 10R
Lexmark 5700
Lexmark Optra Color 45
Lexmark Optra C710
Lexmark Optra E, E+, E310
Lexmark Optra K1220
Lexmark Optra M410, M412
Lexmark Optra N
Lexmark Optra R+
Lexmark Optra S1250, S1855
Lexmark Optra SC-1275
Lexmark Optra SE-3455
Lexmark Optra T614
Lexmark Optra W810
Lexmark Z53

Appendix: DP-300U Printer Compatibility List (continued)

The Fujitsu Printer
Parallel:
Fujitsu 10V
Fujitsu 14V
Fujitsu DL-700
Fujitsu DL-3800

The IBM Printer
Parallel:
IBM 5577
IBM 4039
IBM 16L
IBM Infor Printer 20
IBM InfoPrint 32

The NEC Printer
NEC P2200
NEC P3200
NEC P5300
NEC P6300
NEC P7300
The OTHER Printers
Brother HL-1260
CD T120
Citizen GSX-230
Futek 84+
OKI ML-391
OKIdata OL-400
Olivetti JP450
Pannsonic 2023
Panasonic KX-P1624
Printtec PR856C
Star NX-2420
Tektronix Phraser 350
Kyocera FS-1000
Kyocera mita FS-1000+


